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Introduction to Flash 
 

Starting Your Project 
 
On the start up screen, from the Create New menu, choose ActionScript 2.0.  ActionScript 3.0 
is the latest programming language but currently there are relatively few tutorials available for 
this, so it is best to use AS2 for now.  Once your project is open, save your file. 
 

 
 

Creating Simple Motions 
 
This section looks at moving objects across the screen, including creating the objects, 
inserting into the movie, adding keyframes and tweening the motion. 
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Creating Objects 
 
When creating Flash movies it is good practice to store your objects in the library, not to draw 
them directly on to the movie background. 
 
First ensure your library window is open by going to the Window drop-down menu and 
selecting Library.   Objects can be imported or created in the library.  For this exercise we 
are going to create objects. 
 

 

New 

To create a new object, press the small + sign in the bottom 
left hand corner of the Library window.  You will then 
have three options: 
 
• Movie 
• Button 
• Graphic 
 
For this exercise select Graphic.  Name your graphic 
‘ball’. 

 
 
 Select the oval tool from 
toolbar on the left and draw 
a small circle in the centre 
of your screen (around the 
cross, or registration point).  
Your graphic has now been 
created.  You then need to 
go back to your movie by 
selecting Scene 1 from the 
top left of the screen. 

 
 

 
You should now see your graphic in the upper window of the library.  Drag and drop this on 
to your movie window in the bottom left corner.  

Creating the Motion 
 
 

Page 2 



Phil Hargreaves  12/09/02 

 
Make sure you switch back to your pointer tool on the Tools toolbar before you start 
manipulating your graphic in the movie. 
 
The graphic is now added to Frame 1 in Layer 1 of your movie (more about layers 
later) 
 

 click 
a 
t 

 
You now need to add more frames.  The default is 12 frames per 
second, so if the movie is spread over 30 frames this is 
approximately 2.5 seconds.  To increase the number of frames, 
right-click on frame number 30 and select Insert Keyframe from 
the pop-up menu. 
 
The first keyframe will then be spread over 29 frames and a new 
keyframe will be in 30. 
 

 
With frame 30 selected, drag your object to the top right of the 
movie window.  This is the new position.  To get your object to 

move smoothly to the 
new position, right
anywhere in the grey are
(frames 1- 29) and selec

Create Motion Tween from the pop-up menu. 
 
Frames 1 – 29 should then turn purple and an arrow will appear.  To test the motion, go to the 
Control drop-down menu and select Play.  You can also see how the movie would look on 
the Internet by using the Test Movie feature. 

 

Click on frame 30 
and drag your 
circle to here 

Other effects include scale, rotate and fade.  
You can experiment with these by selecting 
frame 30 of your object and then right 
clicking on your object.  You will see the 
options in the pop-up menu. 
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Adding Layers 
 
When you are inserting more than one object it is sometimes appropriate to use separate 
layers.  For example if you want two objects moving at the same time. 
 
Go back to the section on creating objects and create a square in your library using the Tools 
toolbar.  Call the object ‘square’. 
 
This object will be placed in a different layer.  Go back to scene 1 of the movie and insert a 
new layer using the Insert drop-down menu.  Click on frame 1 of layer 2 and drag and drop 
your square on to the movie window in the bottom right corner. 
 

 
Next click on frame 30 and insert a keyframe.  Place the object in the new position in frame 
30 and create the motion tween (see previous section).  You should now have two objects 
moving simultaneously in your movie. 
 

 
 

More Complex Motion 
 

You can also create more complex motions by inserting keyframes 
at any point in your motion tween and repositioning your object.  
For example, if you use your ball, which moves diagonally across 
the screen from the bottom left, you could insert a keyframe in 
frame 15 and move the ball to the bottom right.  The tween will 
recalculate and now move your ball to the bottom right and then to 
the end position in the top right. 
 
Using this technique you can 
create motion to different 
positions on the screen.  To 
achieve motion such as an arc it 
is better to use a motion guide 

(next section) 

New Motion 
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Motion Guides 
 
Motion Guides are used for very complex 
motions such as arcs or bouncing balls 
etc.  A motion guide is a layer attached to
the layer containing your object.  You 
draw your motion using the drawing tools 
in the guide 

 

layer. 
 
Using a new file create a circle in your 
library and drag this into layer 1.  Insert a 
Keyframe at frame 40.  Next go to Insert, 
Timeline and Motion Guide. 
 

This will add your guide layer (see diagram below).  Make sure you select 
frame 1 of the guide layer and draw your motion with the pencil tool.  
 

 
Now you need to click on frame 40 of layer 1 (the layer containing your circle) and guide 
your circle slowly over the motion guide.  Create the tween in layer 1 and test the movie.  
This does not always work the first time.  If it doesn’t work, ie. your circle doesn’t follow the 
guide, click in frame 40 of layer 1 and guide your object over the motion guide again.  This 
can take some practice.  Your motion guide won’t display in the Test Movie. 
 

Draw your motion 
guide in the guide 
layer using the 
pencil tool 
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Nested Animations 
 
Nested Animations are a way of creating complex movements such 
as legs, arms and wings etc in a ‘movie clip’ and still allow simple 
movements in the main scene.  Nested animations are small movies 
created in the library.  This example illustrates a person walking. 
 
Create two graphics in your library – a back leg and a front leg.  Use 
the paint tool and keep the graphics simple for now. 
 
Next create a new object in your library called ‘legmove’ and make 
this a Movie Clip rather than a graphic. 
 

 
Drag your back leg on to layer 1 of the movie 
and insert a keyframe in frame 10 and a keyfram
in frame 5.  Create a rotate movement by 
clicking on the keyframe at 5, right-clicking on 
your object and choosing Free Transform.  Nex
move the rotation point on to the registration 
point at the top of the leg, rotate the leg forward
and create tweens between frames 1 to 5 and 5 to
10.  Insert another layer and repeat this process 
the new layer with the front leg rotating in the 
opposite d

e 

t 

 
 

in 

irection. 
 

 

 
 
Note you can’t use the Test Movie feature when working in the library. 
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You should now have two legs rotating in two layers over 10 frames. 
 

 
 
Now create another graphic for the body.  Once you have this you can then combine the 
legmove movie clip with the body graphic in the main scene to get a walking effect across the 
screen.  You will need the objects in separate layers and tween the motion from left to right. 
 

 
 
Playing the movie in the design view won’t show the legs moving, you need to test the movie 
to show all the motion. 
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Buttons 
 
Buttons are used to add interactivity to your movies.  Buttons are created in your library and 
you can use the drawing tools to make them.  To make a new button create a new object and 
hoose button from the properties window.  A button uses the Flash programming language 

n called ‘clickme’. 

 has 4 states: 

 
 Down 

s such as a 
glow when the m

D

uble click GetURL.  You can 
e UWE web address 

 
 
 

c
“ActionScript” to allow user interaction. 
 

 
First create a new butto
 
A button
 
• Up 
• Over
•
• Hit 
 

Different images can be placed in these frames to create effect
ouse pointer rolls over the button.  For this example use 
raw a rectangle and add the text Click Here.   the Up frame.  

 
Next go back to Scene 1 and add your button to the 
scene.  Right click on the button and choose actions. 
 
For this example, we are going to make a link to the 
UWE web site. 
 
In the actions window do
then enter th
(http://www.uwe.ac.uk). 
 
 
 
 

Page 8 



Phil Hargreaves  12/09/02 

 
 

 
 
Test the movie and click on your button.  You can also add movement to your button. 
 
 

The Over Frame 
 
To make your button dynamic you can add an image in the over keyframe.  When the user 
rolls the mouse pointer over the button the new image will be displayed.  This could just be a 
simple colour change. 
 
For example, go to your previous button design by double clicking in the library window. 

 
Right click on the over frame and insert a keyframe.  This 
will also insert the graphics from the Up frame.  Select the 
graphic in the Over frame and change the background to a 
contrasting colour.  Once placed on the main scene, this w
give the effect of a colour change when the use rolls over.  
This can also be used for other applications such as pop up 
information boxes.  You can also do this in the Down frame 
which will be activated when the user clicks 

ill 

on the button. 
 

 

The Hit Frame 
 
The hit frame is for creating Hit Areas.  These are invisible areas that define where the user 
can click for the action to happen.  These are especially useful for text only or loine drawings.  
If text only is used the user has to click on a solid portion of the text.  Drawing an invisible 
rectangular hit area around this ensures the event happens when the user clicks on the text.  
To do this simply insert a keyframe and use your rectangle tool to draw and box around the 
text or line drawing. 
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Movie Properties 
 
The Movie Properties function is 
for setting global attributes like 
size and background colour.  To 
access the movie properties, click 
anywhere on your movie and use 
the Size button Properties toolbar  
 
Note: it is wise to decide on the 
size of your movie at the very 
start of your project and de
graphics accordingly.  It is very 

time-consuming to change these later. 

sign 

 
The dimensions of your movie are set throughout and will affect any additional scenes. 
 

Manipulating Frames 
 
Before using ActionScript for more complex procedures, it is worth knowing how to 
manipulate frames and keyframes so you can place them where and for as long as you want 
on the time line. 

Setting the Range 
 
To expand a keyframe over a number of frames, you can use the Ctrl key in conjunction with 
clicking and holding the mouse button.   
 
For example if you have a single keyframe at frame 1 on the timeline and you want this to run 
over 30 frames, you would hold down the Ctrl key, click and hold on the keyframe and drag 
to frame 30. 
 

 

 
Note:  this is only one keyframe - the circle at the beginning indicates the start of the 
keyframe and the square at the end the end of the keyframe. 
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This can also be done the other way round without using the Alt key.  For example, if you add 
an object to a new layer that already has objects running over 30 frames on other layers, the 
object will be automatically added to a keyframe covering 30 layers, ie to the end of the 
movie.  If you want to shorten this, click and hold on the square at the end of the keyframe 
and drag to the new position. 
 

Moving a Frame 
 
To move a keyframe, click and hold and drag to the new position. 
 

 

 
Note: if you have more than one keyframe for an object, any actions added to the object 
associated with that keyframe will only be applicable for the one keyframe.   
 
Try these techniques on the next example (Introduction to ActionScript). 
 

Inserting Keyframes 
 
You should already have experience of inserting keyframes to create movement.  For example 
if you add an object to a layer at frame one, you can then insert a keyframe at frame 30, set 
the movement.  When you create the motion tween it is set on the first keyframe over frames 
1 – 29.  If you want to insert a keyframe without the object appearing on the movie window 
you can insert a blank keyframe. 

Copying and Pasting Frames 
 
Copying and pasting frames is a useful technique, especially if you want to make similar 
movies over several scenes (see later) and make slight changes.  To copy an entire move click 
on any frame in the timeline.  Next press Ctrl + A or choose Select All from the Edit menu.  
Next choose Copy Frames from the Edit menu.  You can then create a new scene or movie, 
click on the timeline and choose Paste Frames from the Edit menu. 
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Introduction to ActionScript 
 
We’ve already looked at using the GetURL action for the Click (on Release) event of a 
button.  There are two main ways of using ActionScript: 
 
• Assigning them to the action on a button 
• Adding them to a keyframe on the timeline of the scene 
 
In the case of the button, the action will be triggered on the specified event eg. on the click of 

the mouse button.  In the case of the keyframe, the action will be triggered when the 
play-head reaches that keyframe on the timeline.  A keyframe can be identified as 
containing an action by the symbol a in the frame. 

 

The Stop Action 
 
This action is commonly used in a keyframe at the end of the movie to force it to stop rather 
than loop.  It can also be used in the body of a movie, in conjunction with a button to create a 
pause or ‘next’ effect. 
 
Either create a new movie over about 30 – 50 frames or use one of your previous examples, 
ensuring there is an object moving on the screen. 
 
 
 
 

 
Choose any final keyframe on any 
layer, right click and select Actions, 
go to Basic Actions and double 
click on Stop.  Test your movie, it 
should stop rather than loop. 
 
The next example looks at using 
stop to pause a movie and then give 
the user choices on what to do. 
 
 
 

The GoTo Action 
 
The GoTo action is commonly used for taking the user to a different place on the timeline or a 
different scene (see later).  For this example we are going to build a movie where a ‘true or 
false’ question appears along with two buttons for each option.  The true button will take the 
user to a ‘congratulations’ message and the false button to a ‘wrong – try again’ message. 
 
First create a graphic with the text “French was the Official Language in England for over 600 
years”.  Call your graphic quest1.  Next add this text to your main scene and fade or move in 
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over 30 frames.  Add a stop action to the keyframe at frame 30 (see previous section).  Next 
create two buttons – one with the text “false” and one with the text “true”.  Add these to two 
new layers over frames 1 – 30 and add some movement.   
 

 
 
Next create two more buttons, one with the text “congratulations!” the other with the text “try 
again”. 
 
On the main scene create two more new layers.  Drag the congratulations button on to a new 
layer and then reposition the keyframe to frame 31 (you can do this by clicking and dragging, 
set this to run over one frame only).  See previous section on how to manipulate frames.  Do 
this on the other new layer with the try again button but position it at frame 32.  Place a stop 
action on each frame. 
 

 
Now the movie will play but will stop on frame 30 as there is a stop action on the question 
layer at 30.  You can now direct the user to the appropriate message by adding GoTo actions 
to the true and false buttons.  To add the true action, right click on the true button in the movie 
window and select Actions.  Select GoTo from basic actions and type in 31 where prompted. 
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Do the same with the false button but type in frame 32.  This way if the user clicks true the 
message will say “congratulations” and if they click false the message will say “try again”.  
You could then add more GoTo actions to the buttons in frames 31 and 32 either moving the 
user on or taking them back.  This is a simple way of making games and quizzes and can be 
done over several scenes. 
 

Inserting Scenes 
 

When building complex movies the timeline can get very long and crowded.  
In this case it is sometimes easier to use different scenes.  In the default state a 
movie will continue playing the scenes in order and then loop but stop actions 
can be added to give the user pauses to make choices. 

 
To insert a scene go to the Insert drop down menu and choose Scene.  You can access the 
different scenes using the menu in the top right corner. 

Importing Graphics 
 
When importing graphics, it is good practice to import them into a graphic object in the 
library before using them in a scene.  If you import a graphic directly into a scene you may 
lose options for manipulating the graphic. 
 
To import a graphic, create a new graphic in the library and then go to File and Import. 

Trace Bitmap 
 
The Trace Bitmap function allows you to import a bitmap file such as a jpeg or gif and 
convert it to the Flash vector format.  This can be useful if you want to edit the image without 
using Photoshop before importing. 
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Import an image as above (in a new library object).  Next select the image and go to Modify 
and Trace Bitmap.  You can then select the parameters for the accuracy of the conversion.  
The colder you get to the original, the larger the file size and the longer it will take. 
 

 
Press OK and the conversion will be completed.  You can then edit the image using the Flash 
drawing tools. 

File Types 
 
There are two main types of file in Flash 
 
.fla 
.swf 
 
The .fla file is for saving your movie so you can continue working on it.  The .swf file is for 
inserting into HTML using an editor such as Dreamweaver.  The .swf files are created 
automatically when you test your movie. 
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